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High voltage ceiling fan reference design

About this document

Scope and purpose

This user guide provides an overview of the reference board REF-SHA35WRC2SYS including its main features,
key test results and mechanical dimensions.

The REF-SHA35WRC2SYS is a full-featured starter kit, with a turnkey motor driver designed for high-performance,
high-efficiency permanent magnet synchronous motor (PMSM) / brushless direct current motor (BLDC)
applications, including all the required elements for high voltage ceiling fan applications. It includes the
iMOTION™ IMD112T driver for PFC and motor control, the 1ED44171N01B for PFC gate driver, IKAOSN65H5
DuoPack IGBTs and diodes for PFC switching, and the TRENCHSTOP™ RC-Series IKNO3N60RC2 that provides
cost-effective, monolithically integrated IGBTs with diode for the inverter stage.

The starter kit features Infineon’s iIMOTION™ driver and advanced motion control engine (MCE 2.0) technology
for PMSM/BLDC motor and PFC driver. It is optimized for small and major home appliances like fans, pumps,
compressors, and other general-purpose variable speed drives.

Note: Please note that this product is not qualified according to the AEC Q100 or AEC Q101 documents
from the Automotive Electronics Council.
Intended audience

This user guide is intended for all technical specialists who are familiar with ceiling fan control and electronics
converters. The reference design is intended to be used under laboratory conditions only by trained specialists.

Reference board/kit

Product(s) embedded on a PCB, with a focus on specific applications and defined use cases that may include
software. PCB and auxiliary circuits are optimized for the requirements of the target application.

Note: The boards do not necessarily meet the safety or quality standards requirements such as UL, CE.
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Important notice

Important notice

“Evaluation Boards and Reference Boards” shall mean products embedded on a printed circuit board
(PCB) for demonstration and/or evaluation purposes, which include, without limitation, demonstration,
reference and evaluation boards, kits and design (collectively referred to as “Reference Board”).

Environmental conditions have been considered in the design of the Evaluation Boards and Reference
Boards provided by Infineon Technologies. The design of the Evaluation Boards and Reference Boards
has been tested by Infineon Technologies only as described in this document. The design is not qualified
in terms of safety requirements, manufacturing and operation over the entire operating temperature
range or lifetime.

The Evaluation Boards and Reference Boards provided by Infineon Technologies are subject to functional
testing only under typical load conditions. Evaluation Boards and Reference Boards are not subject to the
same procedures as regular products regarding returned material analysis (RMA), process change
notification (PCN) and product discontinuation (PD).

Evaluation Boards and Reference Boards are not commercialized products, and are solely intended for
evaluation and testing purposes. In particular, they shall not be used for reliability testing or production.
The Evaluation Boards and Reference Boards may therefore not comply with CE or similar standards
(including but not limited to the EMC Directive 2004/EC/108 and the EMC Act) and may not fulfill other
requirements of the country in which they are operated by the customer. The customer shall ensure that
all Evaluation Boards and Reference Boards will be handled in a way which is compliant with the relevant
requirements and standards of the country in which they are operated.

The Evaluation Boards and Reference Boards as well as the information provided in this document are
addressed only to qualified and skilled technical staff, for laboratory usage, and shall be used and
managed according to the terms and conditions set forth in this document and in other related
documentation supplied with the respective Evaluation Board or Reference Board.

It is the responsibility of the customer’s technical departments to evaluate the suitability of the
Evaluation Boards and Reference Boards for the intended application, and to evaluate the completeness
and correctness of the information provided in this document with respect to such application.

The customer is obliged to ensure that the use of the Evaluation Boards and Reference Boards does not
cause any harm to persons or third party property.

The Evaluation Boards and Reference Boards and any information in this document is provided "as is"
and Infineon Technologies disclaims any warranties, express or implied, including but not limited to
warranties of non-infringement of third party rights and implied warranties of fitness for any purpose, or
for merchantability.

Infineon Technologies shall not be responsible for any damages resulting from the use of the Evaluation
Boards and Reference Boards and/or from any information provided in this document. The customer is
obliged to defend, indemnify and hold Infineon Technologies harmless from and against any claims or
damages arising out of or resulting from any use thereof.

Infineon Technologies reserves the right to modify this document and/or any information provided
herein at any time without further notice.
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Safety precautions

Note: Please note the following warnings regarding the hazards associated with development systems.

Table1 Safety precautions

Warning: The DC link potential of this board is up to 1000 VDC. When measuring
voltage waveforms by oscilloscope, high voltage differential probes must be used.
Failure to do so may result in personal injury or death.

Warning: The evaluation or reference board contains DC bus capacitors which take
time to discharge after removal of the main supply. Before working on the drive
system, wait five minutes for capacitors to discharge to safe voltage levels. Failure to
do so may result in personal injury or death. Darkened display LEDs are not an
indication that capacitors have discharged to safe voltage levels.

Warning: The evaluation or reference board is connected to the grid input during
testing. Hence, high-voltage differential probes must be used when measuring voltage
waveforms by oscilloscope. Failure to do so may result in personal injury or death.
Darkened display LEDs are not an indication that capacitors have discharged to safe
voltage levels.

Warning: Remove or disconnect power from the drive before you disconnect or
reconnect wires, or perform maintenance work. Wait five minutes after removing
power to discharge the bus capacitors. Do not attempt to service the drive until the bus
capacitors have discharged to zero. Failure to do so may result in personal injury or
death.

Caution: The heat sink and device surfaces of the evaluation or reference board may
become hot during testing. Hence, necessary precautions are required while handling
the board. Failure to comply may cause injury.

Caution: Only personnel familiar with the drive, power electronics and associated
machinery should plan, install, commission and subsequently service the system.
Failure to comply may result in personal injury and/or equipment damage.

Caution: The evaluation or reference board contains parts and assemblies sensitive to
electrostatic discharge (ESD). Electrostatic control precautions are required when
installing, testing, servicing or repairing the assembly. Component damage may result
if ESD control procedures are not followed. If you are not familiar with electrostatic
control procedures, refer to the applicable ESD protection handbooks and guidelines.

Caution: A drive that is incorrectly applied or installed can lead to component damage
or reduction in product lifetime. Wiring or application errors such as undersizing the
motor, supplying an incorrect or inadequate AC supply, or excessive ambient
temperatures may result in system malfunction.

Caution: The evaluation or reference board is shipped with packing materials that
need to be removed prior to installation. Failure to remove all packing materials that
are unnecessary for system installation may result in overheating or abnormal
operating conditions.

>R B B BB
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1 The board at a glance

The REF-SHA35WRC2SYS is a part of Infineon’s TRENCHSTOP™ IGBT, gate driver and iMOTION™ driver
reference design kits. It is designed to provide a ready-to-use ceiling fan solution based on the above-
mentioned technology as well as on the advanced motion control engine (MCE 2.0).

The REF-SHA35WRC2SYS is an optimized design for 35 W high voltage ceiling fan applications. It allows fast
prototyping and a fast time to market. It is available through regular Infineon distribution partners as well as on
Infineon's website. The main features of this board are described in Chapter 1.3 of this document. The
remaining sections provide information for customers, enabling them to copy and modify the design for
production according to their specific requirements.

Environmental conditions have been considered in the design of the REF-SHA35WRC2SYS. The design was
tested as described in this document, but not qualified in terms of safety requirements or manufacturing and
operation over the whole operating temperature range or lifetime. The boards provided by Infineon are subject
to functional testing only.

The boards are not subject to the same procedures as regular products in terms of returned material analysis
(RMA), process change notification (PCN) and product discontinuation (PD).
1.1 Delivery content

The scope of delivery contains the main board REF-SHA35WRC2SYS and daughter board XMC1100_IR_RC as
shown in Figure 2 to Figure 5, one connecting cable, and remote infrared control box. The detailed ordering
information is indicated in Table 2.

Table 2 Delivery content
Base part number Package Standard pack Orderable part number
Form Quantity
REF-SHA35WRC2SYS Boxed 1
XMC1100_IR_RC Boxed 1
REFSHA35WRC2SYSTOBO1
Cable Boxed 1
Remote infrared control box Boxed 1
User guide 6 of 56 V3.1
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1.2 Block diagram

The block diagram of the REF-SHA35WRC2SYS is depicted in Figure 1.

Mains
120...265V~
— AC/DC
Auxiliary power 14V -]
supply 1
Gate driver
5V 3 Phase
< inverter
Duty
IMD112T
Figure 1 Block diagram of the REF-SHA35WRC2SYS

Figure 2 to Figure 5 depict the functional groups of the main board REF-SHA35WRC2SYS and daughter board
XMC1100_IR_RC.

1. AC power input connector L, N and PE
2. Surge, EMI and soft start circuit

3. PFC inductor and IGBT IKAOBN65H5

4. Auxiliary power supply

5.iMOTION™ link connector (J1)

6. Infrared daughter board connector (J2)
7. Ceiling fan motor connector (J3)

8. DC bus capacitor

Figure 2 Functional groups on top side of the main board REF-SHA35WRC2SYS
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1. IGBT IKNO3N60RC2 (mounted per
default) or IKDO4N60ORC2

2.iMOTION™ driver IMD112T-6F040

3. Auxiliary power supply

4. Rectifier

5. PFC Gate Driver 1IED44171NO1B

Figure3 Functional groups on bottom side of the main board REF-SHA35WRC2SYS

1. Infrared signal receiver

Figure 4 Functional groups on top side of the daughter board XMC1100_IR_RC

1. XMC1100-Q024F0064
2.XMC1100-Q024F0064 programming connector (J2)
3. Main board REF-SHA35WRC2SYS connector (J1)

Figure 5 Functional groups on bottom side of the daughter board XMC1100_IR_RC
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1.3 Main features

The REF-SHA35WRC2SYS board is an optimized reference design for 230 Vs ceiling fan applications. It contains
iMOTION™ driver IMD112T for controller and inverter driver, TRENCHSTOP™ RC-Series cost-effective,
monolithically integrated IGBT with diode IKNO3N60RC2 for inverter switches, 650 V DuoPack IGBT and diode
IKAOBN65HS5 for PFC switch, and 1ED44171N01B for PFC gate driver.

Major REF- SHA35WRC2SYS characteristics include:

+ Infrared remote interface for ceiling fan speed control

Last-used setting speed command restore function after re-power

+ DC bus tracking input voltage in PFC control

+ Inputvoltage range 120~265 Vims, Normal input voltage 230 V:ms, DC-bus voltage of up to 450V
« Maximum input power 35 W at T,;=25°C with input voltage range of 120~265 Vims

+ PFCfactor=0.9 at normal input voltage 230 Vims and maximum input power of 35 W

+ iTHD =10% at normal input voltage 230 Vims and maximum input power of 35 W

+ 650V DuoPack IGBT and diode for PFC switch

+ Single-channel, low-side IGBT gate driver IC for PFC switch driver

« On-board 0.3 A, 10 mH PFC inductor for 60 kHz PFC operation

+ Cost-effective, monolithically integrated 600 V Reverse Conducting Driver 2 for 16 kHz PWM motor control
« iMOTION™driver for PFC and motor control

+ Overcurrent protection

« Auxiliary power supply with 14V

« 5Vsupply by on-board iMOTION™ driver

+ Main board PCB with 90 mm diameter cycle, single layer, 1 oz. copper

+ Daughter board with 15 mm x 9 mm, 2 layers, 1 oz. copper

+ RoHS compliant

User guide 9 of 56 V3.1
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1.4 Board parameters and technical data

Table 3 depicts the key specifications of the reference design of REF-SHA35WRC2SYS.

Table 3 REF-SHA35WRC2SYS board specifications
Parameter Symbol | Conditions Value Unit
Input voltage Vac Optimized design for 230 Vims applications 120~ 265 | Vims
Maximum input current | lacmax Input 120 Vims, input power = 35W, T,=25°C, 290 MAms

Motor fpwu= 16 kHZ, PFC fpwn=60 kHz
natural cooling mode

Normalinput current lactorm) | Input 230 Vims, input power = 35W, T,=25°C, 155 MAms
Motor fpwu= 16 kHZ, PFC foun=60 kHz
natural cooling mode

Maximum input power | Pinmay | Input 120 ~ 265V s, input power = 35W, T,=25°C, 35 W
natural cooling mode

Maximum motor Imtrmaxy | INput 230 Vs, input power = 35W, T,=25°C, 130 MAms
current Motor feww= 16 kHz, PFC fpun=60 kHz,
Natural cooling mode
DC bus voltage
Maximum DC bus Vaemaxy | DC bus capacitors are 450V, 22 puF 450 v
voltage
Minimum DC bus Vacminy | Aux power supply brown-in voltage 25 v
voltage
Current feedback
PFC shunt resistance RS1 Direct AD sample, two 0.25 W, 2Q) shunt resistor 1 Q
paralleled
Motor shunt resistance | RS2 Direct AD sample, two 0.25 W, 2Q) shunt resistor 1 Q
paralleled
Protections
PFC current protection | PFClyp, | IMD112T’s internal comparator for cycle-by-cycle 8531 MApeak
trigger level OCP, trip level can be adjusted by R15 & R16
Motor current Mtrlyip | Wizard setup for OC trigger level, related to AD 5002 MApeak
protection trigger level range, shunt resistor RS3, RS4 and pull-up bias
Auxiliary power supplyl - 14V
Output voltage Vavour | Used for IPM driver 14+2% |V
Maximum output lauouts 175 mA

current

1 ForiMOTION™IC IMD112T PFC overcurrent protection, there are two options in the MCEWizard setup.
If you select “Cycle-By-Cycle” mode, the PWM output immediately goes to logic LOW when the inductor current exceeds the pre-
determined OCP threshold, and re-starts at the following PWM cycle.
If you select “Latch-off” mode, PFC state machine would shift from RUN state to FAULT state when the inductor current exceeds the
pre-determined OCP threshold for a duration specified by parameter “PFC_GateKillTime”, only Fault_clear command can make it
back to STOP/RUN mode.

2 ForiMOTION™IC IMD112T, there is only one type of Gatekill input source in MCEWizard setup: comparator. The feedback current will
be compared by the internal comparator with the “Overcurrent Trip Level for Internal GateKill Comparator” value set in MCEWizard.
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Parameter l Symbol‘ Conditions ‘ Value ‘ Unit

Auxiliary power supply2 - 5V

Output voltage Vavourz | Supplied by IMD112T and power daughter board 5+4% v
Maximum output lavout2 10 mA
current

PCB characteristics

Main board dimension Diameterx height, single layer 90x65 mm
Material FR4, 1.6 mm thickness, 1 oz. PCB
Daughter board Length x width x height, double layer 19x15 mm
dimension x11
Material FR4, 1.6 mm thickness, 1 oz. PCB
System environment
Ambient temperature ‘ Ta ‘ Non-condensing, maximum RH of 95% 0~50 °C
User guide 11 0of 56 V3.1
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2 System and functional description
2.1 Commissioning

This section describes how to get the system working after the user has installed the board. The following items
detail these steps. For those who are familiar with the system, or who have already run the board, some of the
steps can be skipped, depending on the user’s situation. For more in-depth start-up requirements, please refer
to the MCE reference manual or the corresponding reference material™®/,

2.1.1 Hardware connection
Figure 6 shows the hardware connection details for the reference design board.

The iIMOTION™ link cable is needed to bridge the PC/debugger side and motor drive system (the target
iMOTION™ device, hot side) with 1 kV DC galvanic isolation. Users can go to Section 5.3 for more information on
the iIMOTION™ link.

1. ConnectiMOTION™ link’s 8-pin cable to main board J1 using the default pin order (only pin 5~8 are used),
and connect PC and iMOTION™link with the USB wire.

2. Then connect AC power supply (L, N, PE) and the motor (J3).
3. Connect main board J2 to daughter board J1 by cable attached in package box.

l

i

/Amu.]

IMOTION™ Link
Isolated Debug Probe

Figure 6 Hardware connection details

Note: The iMOTION™ link shown in Figure 6 is required for commissioning, but it is not included in the
delivery content. It can be ordered separately according to the details in Section 5.3.
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2.1.2 Software tools preparation

The iIMOTION™ software tools, MCEDesigner and MCEWizard, are required to set up the system, as well as to
control and fine-tune the system performance to match users' needs. These tools are available for download
via the Infineon website (http://www.infineon.com/imotion-software). Please check this page periodically for
software tools updates. Regarding the use of MCEDesigner and MCEWizard, please refer to the “MCEDesigner
Application Guide” and the “MCEWizard User Guide,” which can be got in the installing path of each tools.

Note: This reference board has been tested by the software tools MCEdesigner v2.3.1 and MCEWizard
v2.3.1. The same performance is not guaranteed for updated software tools.

2.1.3 Firmware preparation

Please download MCE firmware via the Infineon website (http://www.infineon.com/imotion-software). Select
the firmware package “IMD112T-F040 MCE Software Package v x.x.x.” and please check this page periodically
for MCE firmware updates. The key files included in the package for IMD112T-F040 commissioning are shown

below.

a) Firmware (“.ldf)

b) Default parameters (‘.txt’)
¢) Default mapfile (‘.map’)
d) MCEDesigner file(“.irc’).

Note: This reference board has been tested by MCE firmware IMD112T-F040 MCE Software Package
v1.3.3. The same performance is not guaranteed for updated software tools and MCE firmware.

Note: This reference bord has been programmed firmware IMD112T-F040_A_V1.03.03.ldf before
shipment, so you can re-progarmmed firmware or not.

2.1.4 Parameter and script files preparation

Welcome Page -

iMOTION™ 2.0 System Configuration Wizard

Ceilling Fan A test in/fineon
Fan A (with TR duty ctrl) k_/T\ \\

V1.1 PCB 10hm X6

16KHz (1:3) + 60KHz PFC

Get MADK Hardware Info Get IMOTION™ Info
 Open System Configuration Fie |
DI e e
Previous Next
Figure 7 Wizard welcome page
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If you are not familiar with the application of iMOTION™ you can log-in to myInfineon and make product
registration, then download the default software package for this reference board. The package includes only
one MCEWizard file (.“mc2’) in which all the parameters related to the board hardware and script code for
remote infrared control have been already configured. To make things easier and save time, you only need to
modify the parameters related to your motor, and generate the parameters as the steps described below.

1. Use MCEWizard to open the MCEWizard file (*.mc2’) as shown in Figure 7, then enter the target motor’s
system parameters in “Advanced Mode > Motor 1” as shown in Figure 8, which will be used to calculate the
controller’s digital parameter set, representing the complete motor drive system.

Advanced Mode -

System Motor 1 PFC

Motor 1 Motor Parameters 2

1 - Motor Model Name

2 - Motor Rated Amps Arms

3 - Motor Poles

4 - Motor Stator Resistance Ohms/phase

5 - Motor Lg Inductance mH

6 - Motor Ld Inductance mH

7 - Motor Back EMF Constant (Ke) V(In-rms)/krpm

8 - Motor Max RPM RPM

9 - Minimum Running Speed RPM

10 - Speed Ramp Rate RPM/sec

Motor 1 Startup Setting

11 - Open Loop Speed Ramp Rate (0 = Disable Open Loop Start-up) RPM/sec

12 - Parking Time (0= Disable Parking) sec

13 - Low Speed Threshold RPM v

Previous Next

Figure 8 Motor parameters input

2. To perfect motor running performance, the key motor control parameters listed in Table 4 may need to be
modified in your commissioning process.

Table 4 Key parameters for perfecting motor running performance
Name of item in MCEWizard Description!
Open loop speed ramp rate Influence motor start up performance.
Parking time Influence motor start up performance.
Low speed threshold Influence motor start up performance.
Low speed current limit Influence motor start up performance.
Current regulator bandwidth Influence motor steady-state running performance.
Speed regulator proportional gain | Influence motor steady-state running performance.
Speed regulator integral gain Influence motor steady-state running performance.

1 Only the influence of each key parameter is briefly described here. For more information of each parameters, please refer to the
description in MCEWizard.

User guide 14 of 56 V3.1
2023-6-15



o _.
REF-SHA35WRC2SYS user guide Infineon
High voltage ceiling fan reference design
System and functional description

3. Ifthe script function for remote infrared control is needed for commissioning, then please go to step 4. if the
script function is not needed for motor initial open-loop and closed-loop commissioning, then please go to
step 5.

4. The script function is enabled by default in the provided MCEWizard file (‘.mc2’). Click menu “Jump to page
> Script” and click label “Script Coding”, then you can edit the script code according to the properties of
motor you used as shown in Figure 13. For more information regarding to script editting, please refer to the
MCE reference manual®. About how to change script to adapt customer motor, please refer to Section 2.4.
Then click menu “Jump to page > Verify & Save Page”, go to “Verify & Save Page” page and click on the
“Calculate Parameters and Compile Script Code” key to calculate parameters and compile script code. If no
errors are reported, then save the drive parameters set in your project directory by clicking “Export to
Designer file (.txt)” as shown in Figure 9. If errors are detected, double-click on the error message
(highlighted in RED) and adjust the related parameters. The saved drive system parameter file will later be
used for programming.

The output files of this step are below:

Table5 Files generated by MCEwizard (script-enabled)
Suffix of file Description
.map Includes the avriables defined in script code and need to import into MCEDesigner .irc
file.
df The code compiled from script code and need to programme.
txt The parameters for this board hardware and need to programme.
File JumptoPage Help
Verify & Save Page -

Verify Parameters

Calculate Parameters and Compile Script Code Display Parameters Results Export to MCEDesigner File (.bd)

Double-Click an item to JUMP to its associated question

Information #1 : Firmware Version

Firmware Version is v1.03.xx¢ [For(.x), means any min version between .0 to .9]
Information #2 : System DC Bus Feedback Scaling

The DC Bus Feedback Scaling is 8.11 counts/Volt and max measurable voltage is 505.00V
Information #3 : Motor 1 Current Feedback Scaling

The Mator Current Feedback Scaling is 4467.92 counts/Apk and range is -0.25 to +0.67 Apk
Information #4 : Systern Configuration Options

->MCE Device OverCurrent Level: 0.5 Apk

->Current Feedback: Single Shunt

-=Motor Current Sensing Range -0.25 to +0.67 Apk

-»Angle Feedback: Flux PLL Angle

-=»Control Mode: Speed Control

-=>Control Input: UART
Information #5 : PFC Vac Scaling

The PFC Vac feedback scaling is 4.05 counts/Vpk and max measurable voltage is 505.00 Vpk
Information #6 : PFC Configuration Options

->Topology: Boost

-»Violtage Mode: Fixed-Voltage

Previous Next

Figure 9 Verify and save page (script-enabled)

5. Click menu “Jump to page > Option” and disable script function as shown in Figure 10. Then click menu
“Jump to page > Verify & Save Page”, go to “Verify & Save Page” page and click on the “Calculate
Parameters” key to calculate parameters. If no errors are reported, then save the drive parameters set in
your project directory by clicking “Export to Designer file (.txt)” as shown in Figure 11. If errors are detected,
double-click on the error message (highlighted in RED) and adjust the related parameters. The saved drive
system parameter file will later be used for programming.
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The output files of this step are below:

infineon

Table6 Files generated by MCEwizard (script-disabled)
Suffix of file Description
txt The parameters for this board hardware and need to programme.

File JumptoPage Help

Options Page -
Basic System Configuration Options

iMOTION™ Device Configuration Options Application Configuration Options
Product Family: IMDLIZT  system Info: | R V1.1 PCB Test|
Controller Device Package: 6F040 -

Firmware Version Select:
Motor 1 WM Frequeney [ 16 ka IScript Function Enable/Disable: I
Motor Fast Control Rate: \ 3

on conl e

p— o

Motor Control Options
Hardware Current Sensing Configuration Options e . Speed Control ~

Motor Current Shunt Configuration: Single Shunt ~ Rotor Angle Calculation Method: Flux PLL Angle ~

Hall Sensor Configuration: None Hall ~ System Monitor
ot ooc: [ 5 20

provus e

Figure 10 Enable/Disable script function in options page

File JumptoPage Help

| Verify & Save Page -

Verify Parameters
Calculate Parameters| Display Parameters Results |Export to MCEDesigner File (.txt)|

Double-Click an item to JUMP to its associated question

 Previous | | Next |

Figure 11 Verify and save page (script-disabled)
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If you are familiar with the application of IMOTION™, you can open MCEWizard and click menu “File > Create
System Configuration File” to create a new configuration file for IMD112T as shown in Figure 12. Then select
“Customized Design For Expert User” and configure as below steps:

)
Welcome Page -

iMOTION™ 2.0 System Configuration Wizard

Welcome to MCEWizard!

This tool is aimed to provide an easy
and intuitive way for configuring a
motor control system based on the
iMOTION motor control ICs.
The starting point of the syster
configuration can be based on
iMOTION MADK boards, which
can be used with or without h|  Creste System Configuration Fie Template from Evaluation Board Setting:
changes for setting up and ru
motor control system. Every
combination of the controller
power MADK board has its

corresponding System Configuration -
File. Similarly, MADK Starter Kits have | | om . —
their own System Configuration File. ‘ o S5 I
Alternatively, the user can define his —

own inverter hardware system by
answerina more auestions durina the

|

Open System Configuration File |

Save System Configuration File I
Ne:

xt

B MCEWizard v23.0.1

Selection Device: | MD112T

Get MADK Hardware Info Get IMOTION™ Info

Previous

Figure 12 New configuration file created for IMD112T

1. Enterthe target motor’s system and operating parameters, as well as the reference board’s hardware
parameters step by step according to MCEWizard user guide[*.

2. Ifthe script function for remote infrared control is needed for commissioning, then please go to step 3. if the
script function is not needed for motor initial open-loop and closed-loop commissioning, then please go to
step 4.

3. Click menu “Jump to page > Option” and enable script function as shown in Figure 10. Copy the script code
for remote infrared control in the Code Listing 1 to “Script Edit Page > Script Coding” in the MCEWizard as
shown in Figure 13. For more information regarding to script editting, please refer to the MCE reference
manual'®. About how to change script to adapt customer motor, please refer to Section 2.4. Then define
pulse input pin for remote infrared control as shown in Figure 14, and please define the pin
“GPI013/DUTYFREQ/PFCG1” as input for this reference board. Then click menu “Jump to page > Verify &
Save Page”, go to “Verify & Save Page” page and click on the “Calculate Parameters and Compile Script
Code” key to calculate parameters and compile script code. If no errors are reported, then save the drive
parameters set in your project directory by clicking “Export to Designer file (.txt)” as shown in Figure 9. If
errors are detected, double-click on the error message (highlighted in RED) and adjust the related
parameters. The saved drive system parameter file will later be used for programming.

The output files of this step are same as Table 5.

4. Click menu “Jump to page > Option” and disable script function as shown in Figure 10. Then click menu
“Jump to page > Verify & Save Page”, go to “Verify & Save Page” page and click on the “Calculate
Parameters” key to calculate parameters. If no errors are reported, then save the drive parameters set in
your project directory by clicking “Export to Designer file (.txt)” as shown in Figure 11. If errors are detected,
double-click on the error message (highlighted in RED) and adjust the related parameters. The saved drive
system parameter file will later be used for programming.

The output files of this step are as same as Table 6.
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Script Edit Page -

Script Configuration  Script Coding

Script File Operation

Copy Script Code from a File... Save Script Code as a File... Script Code Compiler...

Script Text Edit

1 #SET SCRIFT_USER_VERSION (1.00) /*Script version value should be 255.255%/ G
2 #5ET SCRIPT_TASKO_EXECUTION_PERIOD (5) /*Script execution time for Task0 in mS, maximum value 65535%/
3 #SET SCRIFT_TASK1_EXECUTION_PERIOD (1) /*Script execution time for Taskl in 10mS, maximum value
65535%/
4 #SET SCRIPT_START_COMMAND (0x3) /= Start command, TaskD : Bit0, Taskl : Bit1; if bit is set, script executes
after init =/
5 #5ET SCRIPT_TASKO_EXECUTION_STEP (10) /* Script Task0 step, This defines number of lines to be executed
every 1mS=/
6 #SET SCRIPT_TASK1_EXECUTION_STEP (30) /* Script Taskl step, This defines number of lines to be executed
every 10mS*/
7
8/
Erassassssassasann]
9
10 int sVar_MotorStatus;//0 for stop, 1 for normal run, 2 for break
11 int sVar_RdDuty;
12 int sVar_RcCmdSpd;

13
14 int sVar_AbsFanSpd; v
Previous Next

Figure 13 Script edit page

ﬁ MCEWizard 23.0.1 - C/Users/JianFeli/Documents/12_HardWareDesigning/09_Ceiling Fan_REF-SHA35WRC25YS/03_Fil...

X
File JumptoPage Help
Script Edit Page -
Script Configuration  Script Coding

Controller Package Type: 6F040 A

Motor Current Sample Circuit: Single Shunt

Motor Control Mode: UART

Multi-Motor Support: MotorID-Disabled

NTC Temperature Protection: Disable

ADC pin configuration

AINO/VSP ) AIN4/NTC O AINS/REFU
AINI/REFW/AHALLL+ | [ INS/VDC AIN U
[ Amymara- | O AING/IV/REFGND/AHALL AIN10/VAC2

AIN3/IPF( AIN7/REFV/AHALL2+ O AIN11/VACL

GPIO pin configuration

GPIOO Input

101 C Output

| GPIO2 | [notused ]
I\ GPIO3/DUTYFREQ/PFCG1 |[ mput -] I
Previous Next
Figure 14 Pulse input pin definition for remote infrared control
2.15 Program firmware/parameters/script

The REF-SHA35WRC2SYS reference design kit is shipped with pre-programmed firmware, parameters and script
code for remote infrared control, since the functional tests are performed before the shipment. Users need to
program their parameters, as the users’ ceiling fan motor may be different from the one under test.

Program the IMD112T-6F040 as follows:

e  Program the firmware of the MCE
e  Program parameter sets for system and motor
e  Program customer script file (optional, depending on whether script function is required)
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or
e  Program the combined file, which is generated by MCEWizard, and contains all three items above.
Customer script file is optional depending on whether it isnecessary. The combined file is usually used
for production, since it only needs to be programmed once.

The programming process is as follows:

1. Startthe MCEDesigner tool, and open MCEDesigner file (‘.irc’) prepared in Section 2.1.3 by clicking “File” >
“Open.”

2. Power the iIMOTION™ control IC with 3.3 V. It is recommended to program the IC with the 3.3 Visolated
power supply that comes from the iMOTION™ link; there is a switch on the iIMOTION™ link to enable/disable
the 3.3 V output. The iMOTION™ control IC will also be powered by the on-board auxiliary power supply
after the AC source is powered. Caution must be taken in the latter case due to high voltage.

Note: The output voltage of LDO combined in the IMD112T-6F040 is 5V, i.e. the controller of IMD112T-
6F040 is powered by 5 V. However, it is also possible to use the 3.3 V power supply in the iMOTION™
link to power the IMD112T-6F040 (for programmers).

3. MCEDesigner should automatically connect to the board using the default COM port (indicated by the green
circle next to “COMx Up” status in the bottom frame of the MCEDesigner GUI) when iMOTION™ control IC is
powered. If it cannot establish the connection due to an incorrect COM port, change the COM port by doing
the following: click on the “System Page” window and then click on “Preferences > Connection > Connect
using” and choose one of the other available COM ports from the drop-down list.

4. Incase of ablank IC: If the firmware has been erased from the IMD112T-6F040, the following warning
message will pop up “Target device firmware and parameters file are not programmed! Please program
firmware and parameters file” as shown in Figure 15. Then you can program the firmware and parameters
as described in Step 5. If it is not a blank IC, no such message will be indicated.

MCEDesigner *

target device firmare and parameters files are not programmed!
! . Please program firmare and parameters files.

Figure 15 MCEDesigner warning message

Operation Options

(" Program Parameters @ Program Firmware and Pararmeters Program Script ( Program Cornbined File

File

Frogram Parameter File |Se|e:t FParameter. document type(®Idf) Browse..

Program Firmware File |Seledfirmwarel document type(* Idf) Browse...

Frogram Script File |

Frogram Combined File |

L

Start Cancel

Figure 16 Program the parameters and firmware

5. Use the following steps to program the firmware and the parameters file to the internal Flash memory of
iMOTION™ Control IC as follows: click on the system page, click “Tools” > “Programmer” and select
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“Program Firmware and Parameters,” as shown in Figure 16. Regarding the firmware and parameters file,
browse and select the “.ldf’ and “.txt’ file prepared in Section 2.1.3 and Section 2.1.4.

6. If the script file needs to be programmed in the internal Flash memory of iIMOTION™ Control IC after
programmed firmware and parameters file, still click on system page, click “Tools” > “Programmer” and
select “Program Script,” shown as in Figure 17. Regarding the Script file, browse and select the
“xxx_Script.ldf’ file prepared in Section 2.1.4. After programming script, please click “File” > “Import Register
Map” to import script (.map) file into MCEDesigner file (.irc), and save this (.irc) file, otherwise a map error
will appear.

Operation Options

(" Program Parameters  Program Firmware and Parameters (@ Program Script © Program Combined File

File

Frogram Parameter File |

Frogram Firmware File |

Frogram Script File |Se|ec1 Script. document type( Idb Browse...

L

Program Combined File |

Start | Cancel |
Figure 17 Program the script
Note: For detailed information on controller programming, refer to AN2018-33 iMOTION™ 2.0 device

programming, MCEDesigner documentation and MCEWizard documentation.

2.1.6 Open-loop diagnostic

Make sure the input power is 230 Vrms, and program only the firmware and parameters file (script function
disabled) without remote infrared script control.

Double-click the “VF Diagnostic” function in the window of motorl, and monitor motor current with
oscilloscope. If the motor current is not sinusoidal, change register TargetSpeed and Vd_Ext in the VF
Diagnostic sub-function, then double-click “VF Diagnostic” until the oscilloscope shows a steady sinusoidal
current with an amplitude of 30~50% motor rate current.

Double-click “lu & Iv_Slow” in “System page > Monitor Definitions.” The motor current feedback should be very
clean and sinusoidal, as shown in Figure 18; otherwise please tune “Gating Driver Propagation Delay & Phase
Shift Window Size” in MCEWizard.

“VF Diagnostic” sub-function can check whether:

e Theceiling fan motor is connected correctly

e The power stage works as expected

e Current-sensing related parameters are correctly configured

e The PCB layout and DC bus decoupling have been done correctly

After “VF Diagnostic” is done, click STOP button (the red traffic light button) or run the “stop motor”
function to stop the motor.

Note: Please do not start PFC in this diagnostic process.
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1000-

=400

-1000

Figure 18 Trace waveform for lu & Iv open loop diagnostic

2.1.7 Closed loop run

Make sure the input power is 230 Vrms, and only program firmware and parameters file (script function
disabled) without remote infrared script.control.

If the VF Diagnostic works correctly, the hardware circuit and signal sampling will work normally, at which point
you can try to run the ceiling fan motor in a closed-loop mode. Follow the steps as listed below.

1. Start the motor by clicking the green traffic light button in the control bar (or double click Start Motor sub-
function in the window of motorl, which is in the group of User Application Function Definitions). The motor
will run if above step works correctly.

2. Check the motor spin direction, adjust the connection order of the motor’s winding; the motor spin
direction must match the normal running direction of the ceiling fan.

3. Set TargetSpeed to about 50% of maximum speed, start “lu & FIx_M” trace with “Auto Repeat on Level,” see

Figure 19. FIx_M is good within the range of 2000~2500 (rated value is 2048), and must be steady and DC-
like.

1000-

Figure 19 Trace waveform for I, & Flx-M at 50% speed

4. If motor closed loop is tuned up, then the PFC can start when the motor is running. Starting the
“PFC_AbsVac & PFC_Iref” trace with “Auto Repeat on Level” (see Figure 20) will show the PFC performance.
The default PFC DC bus target value is setin MCEWizard “Target DC Bus Voltage Initialization.”

User guide 210f56 V3.1
2023-6-15



o _.
REF-SHA35WRC2SYS user guide Infineon
High voltage ceiling fan reference design '

System and functional description

1800

100 150

Figure 20 PFC_AbsVac & PFC_lIref

5. Once the firmware has been programmed, and only a new parameter file has to be programmed, follow the
same instructions given in Section Figure 14. In this case, the firmware programming is no longer needed,
and you can select the first option “Program Parameters.”

Here are some key tips for better motor-performance commissioning:

e If FIx_Mis not steady (swing or oscillation), check the following: motor parameters, speed loop PI
bandwidth, current loop bandwidth, flux estimator time constant and PLL Pl bandwidth (parameters PLLKp
and PLLKi) and related equipment.

o If FIx_Mis very noisy, check the following: current feedback and V4. feedback related hardware and
parameters.

e If Flx_M does not come close to 2048, “Motor Back EMF Constant (K.)” needs to be adjusted in MCEWizard.

e The PFC parameters in the software package downloaded from mylInfineon are optimized for the reference
board. So it is not necessary to change them.

2.1.8 Infrared control commissioning
If the open-loop diagnostic and closed loop work correctly, then the infrared control can be tuned.

1. Connect the J2 of main board to J1 of daughter board by cables, as shown in Figure 6. The daughter board
can receive remote infrared commands from the control box.

2. Program firmware, parameters file (script function enabled), and script file for remote infrared control by
iMOTION ™link. The iIMOTION ™link can be removed after programming if you do not want to view the MCE
variables’ wave or value from MCEDeisgner.

3. The attached remote infrared control box is shown in Figure 6. There are only power,and 1, 2, 3,4,5
buttons. The power button is to enable or disable controller transmitting. If the controller transmitting is
enablbed, you can select incrementally different motor speeds with button 1,2, 3, 4, 5. Button 5 refers to
maximum motor speed. The daughter board can remember the last set speed by the control box before
power button being disabled or the daughter board power off, so the motor will start at the last-used
setting speed when power button is enabled or the daughter board power on.
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2.2 Description of the main board functional blocks

2.2.1 EMI filter and surge protection

Figure 21 shows the diagram of the EMI filter and surge protection. The EMI stages consist of two X-capacitors
of 22nF respectively, two series Y-capacitors of 3.3 nF and 4.7 nF respectively, and a 22 mH common-mode

inductor. The surge protection circuit consists of two stages of MOV, RV1 and RV2; their reverse break down
voltage is 470 V.

X1
F1
IE L — ~ -— ~
3A. 250Vac lé L3 gllM ];fM
R o 1 4 .
X2 NTC1 VT B Nl m__% W N N
B N i 22mH S ﬁ——%
2 ; e LB0522 = 8 |
94¥ 10R S :
470v 1L eyt 9N 2
| 47nF ©L =
devs Lceva —s
T 33n0F 7T 3.30F
| cY2 VNN
X3 11 4.9nF
Ij EARTH D2 D4
7 IN4007G-K SIM
Figure 21 EMI filter and surge protection
2.2.2 DC bus sensing and MCEWizard configuration

Figure 22 shows the detail of the DC bus sensing resistor divider stage.

With the values shown in the figure, the default DC bus-sense voltage results in a range of 0Vto 5V on the ADC
input of the microcontroller (MCU), reflecting an input voltage range from 0 V to 505 V.

DCP

R22
IMEG

1+

Cl6

uF Max Vdc: 505V @5V

VDC

Cl18
10k

10| o

%

Lvp

Figure 22 DC bus sensing

The hardware parameters need to be configured in MCEWizard as shown in Figure 23.
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File JumptoPage Help

Advanced Mode -

System Motor 1 PFC

L —— T°F A
21 - User UART Tx Delay Time 0 ms

System Options

23 - Safty Function Tests Enable/Disable Disable
24 - Controller Supply Voltage 50 v|V
25 - Temperature-based CPU clock compensation Enable -~
26 - Control Input measurement Enable -
31 - Parameter Set Number 0

System DC Bus

46 - Maximum DC Bus Voltage 500 v
47 - DC Bus Over-Voltage Level 440 |V

48 - DC Bus Under-Voltage Level 80|V
49 - DC Bus Critical Over Voltage Level 499 v
50 - DC Bus Sensing High Resistor ’W KOhms
51 - DC Bus Sensing Low Resistor ’710 KOhms
v
Previous Next

Figure 23 DC bus sensing configuration in MCEWizard

The Vdc-sensing stage features a low-pass-filter time constant that can be calculated as:
Time constant = (R22//R21) x C18 = (1 MQ//10 kQ) * 10 nF = 99 us Eqg. 1

The value of capacitor C18 can be adjusted to improve the V4 noise rejection ratio.

2.2.3 Inverter section

The inverter section is implemented with the latest generation of RC-D2 IGBT in a SOT223 package
IKNO3N60RC2 or in a DPAK package IKD0O4N60RC2. The default mounted devices are IKNO3N60RC2. 600 V RC-D2
is the successor to the RC-D/DF IGBT. The latest version of the RC-D technology has several improvements
compared to its older version: better price, lower power losses, and better controllability over the di/dt to
further reduce EMI compared to RC-D/DF. These devices are also robust for high- temperature and high-
humidity operations.

Features of IKNO3N60RC2 and IKDO4N60ORC2:

« Very tight parameter distribution

+ Operating range of 1 to 20 kHz

« Maximum junction temperature of 175°C

« Short-circuit capability of 3 us

+ Best-in-class current versus package size performance
+ Qualified according to JEDEC for target applications

« Robust design for high-humidity operation

+ Pb-free lead plating; RoHS compliant

« Complete product spectrum and PSpice Models

Figure 24 shows the diagram of the inverter and peripheral circuit.
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infineon

DC+

’_@x
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IFB+ COM_|¢ro--COM . » .
_ch.? RS3 RS4
33aF R R
X6
coM

IKNO3N60RC2 IKNO3N60RC2 IKNO3N6ORC2
2 4 6
R4 oop Q R30 o Q R34 E
{UH D7 {VH Dy ¢ {WH DI2
BAV16WS-7-F BAVI6WS-7-F BAV16WS-7-F
13
- U 1
o T - A I
) ’ wo W ile
! 691102710003
IKNO3N60RC2 IKNO3N60RC2  IKNO3NGORC2
Q3 Qs ) Q7
R25 4 R o R3S }
{OL D8 L D10
BAV16WS-7-F BAV16WS-7-F BAVI6WS-7-F
P13

Figure 24 The inverter and peripheral circuit
2.2.4 Motor current sensing and overcurrent protection
2.24.1 Motor current sensing

The motor current sensing on this board uses only a RC network for operational gain, bias and low-pass filter to

minimize the cost. No additional operational amplifier is needed.

With reference to Figure 25, you can derive the following equation by applying the principle of Kirchhoff's
voltage law, assuming that the MCU analog-to-digital converter (ADC) input port has an infinite impedance.

(Vcc shunt)
% ——* R + V.
ADC = R1 + R2 1 shunt
The equation can thus be adjusted as shown:

v — RZ * Vshunt Rl * Vcc
ADC™ R 4+R, "R, +R,

Since the impedance of the RC network is much larger than the Rgp ,ns, it follows that:

Vshunt = Ishunt * Rshunt

As a consequence, Vapc can then be written as:

R, Rl * Vcc
Vapc = R +R, " Rsnunt * Isnunt + m
Where 1“;6 is the offset, and the gain of the shunt current is —— % Rshunt-
1 2 1
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Figure 25 Motor current-sensing topology
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Figure 26 Motor current-sensing circuit on the board
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As an example in Figure 26, this board has the following values: R1=R1=47 Q, R2 =R4 =1 kQ, Rs = RS3//RS4 =

1Q, V.. =5V. By using the formula in Eq. 5, the offset is 224 mV, and the gain is = IizR * Ropune = 955 mV/A.
1 2

Because the amplitude attenuation of low-pass filter, the gain needs to be amended to 909 mV/A for
MCEWizard configuration.

Note the following points concerning motor current sensing:

e R1landR4in Figure 26 determine the ADC operational bias for current sensing, which corresponds to the
motor regeneration operation range. For applications that do not work with a regenerative braking mode,
the bias can be as low as possible to reserve enough ADC range for the drive mode, since the current in the
sense resistance always flows in one direction only. In this example, the offset is 224 mV.

e Since the gain of the external RC circuit is less than 1, internal signal amplification is required to increase the
current signal acquired with low shunt resistance values. MCE provides an inner current sampling amplifier
with *1, *3, *6 and *12 gain selections, which can be configured in the MCEWizard. In this example, the inner
current sampling amplifier is *6, so the current sampling range is from 224 mV to 833 mV.

e There is no common mode noise suppression capability without an outer operational amplifier, so the GND
network of the PCB needs to be designed very carefully, since any voltage difference between IMD112T’s
ADC ground and shunt resistor ground will be considered as an “input signal,” and will deteriorate the
control performance or increase audible noise.

2.2.4.2 Motor overcurrent protection

The motor overcurrent condition can be detected by IMD112T-6F040 with internal comparator as shown in
Figure 27.

Inverter

DC Bus J

J L

- MCE Device

]
—o
PWM(UH) in
—o
PWM(UL) in
—o
PWM(VH) in
Digital
Fiter +>‘*iD__OPWMWU
PWM(VL) in
T e
—o0
PWM(WH) in

:
" > e D=
PWM(WL) in

Figure 27 Motor overcurrent protection topology
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m
-
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1U /1SS

) - |
R1 | Over Current |
Rs c1 Protection
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h
| v i
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For more details about motor overcurrent protection (OCP) in the IMD112T, please see the chapter about motor
overcurrent protection in the reference material ..

The internal comparator’s reference level is set by the internal digital-to-analog converter (DAC) so the level
can be set in the MCEWizard by “Overcurrent Trip Level for Internal Gatekill Comparator” and “Motorl current
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input to ADC offset voltage.” The DAC output pin REFU needs to be connected to a capacitor to improve noise
rejection (e.g. a 100 nF/25V capacitor is used on the board as shown in Figure 26).

2.2.5 PFC section

Figure 28 provides the PFC MOSFET driver and peripheral circuit.

14 3
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SIM] a BN

[
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BAVIGWS-7-F TEDHTTINGIE l E
=—CcC19 cw
[&T®

Figure 28 The PFC and peripheral circuit

e An1ED44171NO01Bis used for the PFC MOS drive. C14, R13 & R14 select the PFC MOSFET switching du/dt;
trade-off between switching noise and power loss is required.

e Thebypass diode D14 is designed to bypass the surge current during surge voltage input.
e Tworesistors (1% tolerance, 2 Q, 0.25 W) are used for PFC current sensing.
e 10mH 0.3 Ainductor is used for PFC.

e 650V DuoPack IGBT with diode IKAON65HS5 is used for the PFC switch. IKAON65H5 belongs to the high-
speed switching series of the fifth generation and has best-in-class efficiency in hard switching and
resonant topologies.

2.2.6 PFC current sensing and overcurrent protection

2.2.6.1 PFC current sensing

The PFC current sensing on this board uses an RC network for operational gain, bias and low-pass filter to
minimize the cost. No additional operational amplifier is needed. The PFC current-sensing topology is as shown
in Figure 29. From the point view of the AD converter, the current input scaling value is the product of the
voltage of PFC shunt resistor and the gain of RC network.

mV
A

ADC port voltage for .
PFC current sample

(Gain)mV

1A PFC current

Figure 29 PFC current-sensing topology
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As shown in Figure 28, two resistors RS1 and RS2 (paralleled) with 1% tolerance, 2 Q, and 0.25 W are used for
the PFC shunt resistor in this reference board. The real AD input voltage can be calculated as below according
to the principle of Kirchhoff's voltage law:

Vv =R p * +—R9*VCC Eq. 6
IPFC_ R9 + R10 sh,PFC sh,PFC R9 + R10 q

1K 18042 = 5V

VIPFC_ = m * 100 * Ish,PFC + m = 0847(mV/A) * Ish PFC +762mV

So the offset of PFC current sampling is 762 mV, and the gain is 847 mV/A. Because of the amplitude attenuation
of the low pass filter, the gain needs to be amended to 806 mV/A for MCEWizard configuration.

Note the following points concerning PFC current sensing:

e Since the gain of the external RC circuit is less than 1, internal signal amplification is required to increase the
current signal acquired with low shunt resistance values. MCE provides an inner current sampling amplifier
with *1, *3, *6 and *12 gain selections, which can be configured in the MCEWizard. In this example, the inner
current sampling amplifier is *6, so the maximum input PFC current-sampling voltage should range from 0
mV to 833 mV (5V/6).

e Inthis reference board design, the voltage level on the PFC current-sensing resistor is negative with
reference to ground, so an ADC operational bias is needed, and PFC current-sensing input polarity should
select “inverting” in MCEWizard. R9 and R10 in Figure 28 determine the ADC operational bias for current-
sensing; the bias value is 762 mV, so the real AD sampling range for the PFC current-sampling voltage ranges
from 0 mV to 762 mV.

e There is no common mode noise suppression capability without an outer operational amplifier, so the GND
network of the PCB needs to be designed very carefully. Any voltage difference between IMD112T’s ADC
ground and shunt resistor ground will be considered as an “input signal,” and deteriorate the PFC
performance and increase harmonic distortion.

2.2.6.2 PFC overcurrent protection

The PFC current-sensing signal feedback to IMD112T-6F040 goes via two pins, the IPFC for PFC control, and the
PFCITRIP for PFC overcurrent protection. The PFC overcurrent condition can be detected by IMD112T-6F040
with internal comparator as shown in Figure 27. The overcurrent threshold is designed by the voltage value at
input pin PFCREF.

MCE Device
PFCREF :
Digital
—_ 1= mepue| | > S o
PWM in
R2 R3 IPFC
I )
Figure 30 PFC overcurrent protection topology
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For more details about the PFC overcurrent protection (OCP) in the IMD112T, please refer to the relevant
chapter in the reference material ©.

Note the following points concerning PFC overcurrent protection:

e The PFC overcurrent threshold of this board is designed by R15 and R16, and the threshold value is

150 2 . 762mMmV-739mV
———— %5V = 73.6 mV . That means the PFC overcurrentis————————— = 854 mA.
10 KQ+150 2 806 mV /A

HALL1/GPIO2 |23 +5V

PFC RI15

10k

PECRER ks Cl5 _JPI2
IuF ﬁ\ls
5 .
prcco AR TprcGy [ MR
p
150R Ofst: 73.9mV for PFC Itrip
Figure 31 PFC overcurrent threshold design on the board

e The PFC overcurrent has two available modes: latch-off and cycle-by-cycle. This reference board uses cycle-
by-cycle mode. For more details about the two PFC overcurrent protection mode, please refer to the
relevant section in the reference material ..

. .
2.2.7 Interface circuit of IMD112T
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Figure 32 Interface circuit of IMD112T
User guide 30 of 56 V3.1

2023-6-15



o _.
REF-SHA35WRC2SYS user guide Infineon
High voltage ceiling fan reference design '

System and functional description

Figure 32 shows the interface circuit of IMD112T:

e The power of IMD112T is 14V and 5V power generated by internal LDO in IMD112T.
e UH, UL, VH, VL, WH, WL provide driver for inverting circuit.

e |FB+COM is the motor current sensing signal.

e |PFC-isthe PFC current sensing signal.

e VAC1 and VAC2 are AC input voltage sensing signals for PFC.

e PFCGO is the PFCdriver.

e PFCREF is the threshold input of PFC overcurrent protection.

e VDCisthe bus voltage sensing signal.

e LED2istheindicator light of IMD112T power on

e IR_Duty is the duty input signal from the daughter board.

e VSP function is only reserved for a wall regulator and is not enabled in this board.

e RX0and TX0 are debugging and programing communication channels to MCEDesigner.

2.2.8 Interface circuit to XMC daughter board
XMC daughter board
'_ - - -GS -GS - - - i
| 12 0
Y a1
T +5v ! :. ----- |e l
. .« SGND2 0
_LCl? ¥ °IR Dutyl
1uF | ] . I
I | P Tt TEsSar |
< | V-Rwssor_ __ !
7R Dute IR Duty
Figure 33 Interface circuit to XMC daughter board

Figure 32 shows the interface circuit to the XMC daughter board. Its function is to power 5 V for the XMC
daughter board and receive the duty signal translated from the remote infrared control box.

Note: For the firmware version V1.03.03 of IMD112T, the infrared signal needs to be translated to duty
signal by the XMC1100 on the XMC daughter board. The IR_Duty signal is the translated duty signal
from the XMC daughter board.

Note: The future updated firmware version of IMD112T, will be able to translate the infrared signal, so
the IR-Duty signal can connect to the infrared receiver directly, and does not need to be translated
by XMC1100.
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2.3 Description of the daughter board functional blocks

This section depicts the XMC daughter board, which receives signals from the remote infrared control box and
translates them to duty signal to control the motor speed of the ceiling fan. The communication protocol
between infrared control box and daughter board is the standard NEC protocol. All the signals received are
decoded in XMC1100 and ouput duty signals. The XMC1100 can store the last output status when it is power off.
So XMC1100 will output last-used duty signal when it is power on again.

2.3.1 Circuit of daughter board
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Figure 34 Circuit of daughter board

As shown in Figure 34, the IRM-3640T receives signals from the remote infrared control box, and XMC1100
translates them to duty signals. The LED1 indicates the width of the output duty and becomes brighter as the
width narrows. LED2 and LED3 indicate that XMC1100 has received infrared signals, but their logic is contrary.
LED2 lights up (is normally off) and LED3 goes off (is normally lit up) when the XMC1100 has received infrared
signal.

The J2 is for programming XMC1100, which was programmed before shippment.

Note: The future updated firmware version of IMD112T will be able to translate the infrared signal, so the
IR-Duty signal can connect to the infrared receiver directly, and does not need to be translated by
XMC1100. Only the components in the green frame need to be mounted. Remember to mount R7,
which is not needed in the present application.

2.3.2 Output duty signals versus infrared control box buttons

Figure 35 depicts the output duty signals from the remote infrared control box. When the power button is
disabled, the output signal is at high level and all other buttons are inactive. When the power button is enabled,
all other buttons on the control box are active. Then you can selelct button 1 ~ 5 for different motor speed.
Please note that all the duty cycle ouput from daughter board is low level active.
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high level L .~ T
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Figure 35 Output duty signals versus infrared control box buttons
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2.4 Description of script code

The script code is to control motor and PFC start/stop, and motor target speed according to ducty signal from
daughter board; it also to control PFC bus target value tracking input voltage and bus target value adjusting
based on motor back-EMF.

Figure 36 shows the flow chart of script code and Code Listing 1 shows all the source code of script. There are
two tasks: Script_Task0 and Script_Task1. Script_TaskO0() executes every 5 ms and Script_Task1() executes
every 10 ms. Script_TaskO() is to get duty signal from the daughter board and output motor target speed value.
Script_Task1() is to get the MCE fault, motor real speed, to control motor and PFC start/stop and adjust motor
target speed and PFC target DC bus value online.

In Script_Task0_lInit(), there is only initialization of status flag sVar_MotorStatus.

In Script_Task0(), the input duty is united to 0 ~ 1000 counts, reprsenting 0.0% ~ 100.0% duty high level width.
The active duty cycle in script need to be substracted by 1000 counts for input duty is low level active. The input
duty is limited from 5% to 95%, the motor and PFC will stop if duty signal is over this limitation. The duty
counts multiplied 16 represent approximate motor target speed, because 16384 counts repesnts max speed set
in MCEwiard. For the motor tested in this article, the max active motor speed is limited to 14386 counts in
script.

In Script_Task1_lInit(), all the cotontrol variables are initialed here. The PIlKp and PlIKi are especially for the
motor tested in this article. They will impact motor harmonic current. As usually, the dault value of PllKp and
PlIKi are ok, so they don’t have to redefine here for customer motor. The initial value of TargetSpeed and
PFC_TargetVolt usually need to be tuned based on customer motor for pferfect start performance.

In Script_Task1(), first, read the fault information of MCE (motor control engine) and PFC. Second, read input
voltage value and filter it, then generate tracking bus voltage target for PFC with adding 10V. Third, read motor
real speed absolute vaule. Fouth, enter into state machine control if the reveived motor target speed is bigger
than 1000 counts and there is no MCE and PFC fault.

When sVar_MotorStatus = 0, start motor with the initial target speed.
When sVar_MotorStatus = 1 and real motor speed over 1200 counts, start PFC with the initial bus target voltage.

When sVar_MotorStatus = 2, first adjust the motor target speed according to the input duty signal. Second,
adjust the bus target voltage according to the real motor speed (motor back-EMF) and input voltage, and limit
the max bus target voltage to 3244 counts (400 V). In the bus target voltage process, usually all the coefficients
need to be tuned based on customer motor, the principle is to ensure that the motor speed can reach the target
speed, not limited by back-EMF for bus voltage is not enough and the bus target voltage is as lower as possible
to reduce power loss.
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Figure 36 Flow chart of script code
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Code Listing 1 Script code for remote infrared control

001 #SET SCRIPT USER VERSION (1.00) /*Script version value should be 255.255*/

002 #SET SCRIPT TASKO EXECUTION PERIOD (5) /*Script execution time for TaskO
in mS, maximum value 65535%*/

003 #SET SCRIPT TASK1l EXECUTION PERIOD (1) /*Script execution time for Taskl
in 10mS, maximum value 65535%*/

004 #SET SCRIPT START COMMAND (0x3) /* Start command, TaskO Bit0, Taskl Bitl;
if bit is set, script executes after init */

005 #SET SCRIPT TASKO EXECUTION STEP (10) /* Script TaskO step, This defines
number of lines to be executed every 1mS*/

006 #SET SCRIPT TASK1l EXECUTION STEP (30) /* Script Taskl step, This defines
number of lines to be executed every 10mS*/

007

008 /*****************************************************************************
***********************/

009

010 int sVar MotorStatus;

011 int sVar RdDuty;

012 int sVar RcCmdSpd;

013

014 int sVar AbsFanSpd;

015 int sVar MCEErrorCode;

016 1int sVar PFCErrorCode;

017 int sVar VacRMS Flt;

018 int sVar FollowPFCCmd;

019

020 int sVar tempO;

021 int sVar_ templ;

022

023 /*

024 Read Dutycycle about 10% ~ 90% (total 664us)

025 Ton is 66us,199%us, 332us, 465us, 598us

026 */

027

028 /*TaskO0 init function*/

029 Script Task0 init()

030 {

031 sVar MotorStatus = 0;

032 }

033

034 Script Taskl init()

035 {

036 sVar MotorStatus = 0;

037 P11Kp = 600;

038 P11Ki = 100;

039 vVd _Ext=0;

040 Vg _Ext=0;

041 AngleSelect =2;

042 CtrlModeSelect =2;

043 Command = 0;

044 PFC_Command = O;

045

046 TargetSpeed= 1600; //initial motor speed 40 rpm

047 PFC_TargetVolt = 2400; //initial PFC target voltage 296V

048 }

049

050 /*****************Tasko Script function*******************/

051 /*****+xx**+RC commnad read and deal 5ms run**FEExkKx*/

052 Script TaskO ()

053 {
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Code Listing 1 Script code for remote infrared control

054 int ControlDutyTemp;

055 // Read ControlDuty: 100~900cts for 10%~90% dutycycle,update every 10 ms

056 // Input low level active

057 ControlDutyTemp = 1000 - ControlDuty;

058 if (ControlDutyTemp < 0)

059 {

060 ControlDutyTemp = 0;

061 }

062 if (ControlDutyTemp > 1000)

063 {

064 ControlDutyTemp = 1000;

065 }

066 sVar RdDuty = (ControlDutyTemp + 7 * sVar RdDuty + 4)>>3; //LPF for 1/8

067

068 //Stop or Wrong input, keep Stop and fix SpdCmd = 0

069 if ((sVar RdDuty > 950) || (sVar RdDuty < 50))

070 {

071 sVar RcCmdSpd = 0;

072 Command = 0;

073 PFC Command = O;

074 }

075 else

076 {

077 sVar RcCmdSpd = sVar RdDuty * 16; //Transfer Dutycycle to speed count

078 //(10% --> 1600cts)

079 if (sVar RcCmdSpd > 14386)

080 {

081 sVar RcCmdSpd = 14386; //1limit motor speed to max speed 360 rpm

082 }

083 }

084 }

085

086 /************Taskl SCI‘ipt function***************/

087 /******************loms run*********************/

088 Script Taskl()

089 {

090 /******Read and LPF*******/

091 //Read MCE and PFC fault

092 sVar ErrorCode = SwFaults;

093 sVar PFCErrorCode = PFC_SwFaults;

094

095 // LPF for Vac RMS

096 sVar VacRMS Flt = (7*sVar VacRMS Flt + PFC VacRMS + 4)>>3;

097

098 //1.414*32= 45,248 // Vacpeak +10V

099 sVar FollowPFCCmd = 81 + (sVar VacRMS F1t * 45 + 8)>>4;

100

101 // LPF for Fan ABS speed feedback

102 sVar AbsFanSpd = (7*sVar AbsFanSpd + abs MotorSpeed + 4)>>3;

103

104 /******Motor and PFC control, (0,1,2 state machine) ****xxxxx/

105 // Stop PWM if CMD is too low or MCE fault

106 if (( sVar RcCmdSpd < 1000) || (sVar MCEErrorCode >0) || (sVar PFCErrorCode
>0))

107 {

108 Command=0;

109 PFC _Command = O;

110 sVar MotorStatus = 0;

111 }
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Code Listing 1

Script code for remote infrared control

112 else // Start Motor and update Spd & TargetVolt

113 {

114 if (sVar MotorStatus ==0) //From STOP to Start
115 {

116 sVar MotorStatus = 1; //Motor start

117 AngleSelect =2;

118 CtrlModeSelect =2;

119 TargetSpeed = sVar RcCmdSpd; //Normal Run Speed
120 Command = 1; //Start motor PWM

121 }

122

123 //Start PFC when motor start OK (speed over Minspd)

124 if ((sVar MotorStatus ==1) && (sVar AbsFanSpd > 1200))

125 {

126 sVar MotorStatus = 2; //Motor started

127

128 //PFC start with a very low voltage REF to reduce power loss
129 PFC TargetVolt = 2400;

130

131 //Start PFC PWM

132 PFC_ Command=1;

133 }

134

135 //Normal PFC and motor run, update PFC and motor speed command
136 if (sVar MotorStatus ==2)

137 {

138 TargetSpeed = sVar RcCmdSpd;

139

140 //360RPM= 14386-->2877-->354V, 16383/5 = 3276 -->404V DCBUS
141 sVar temp0 = sVar AbsFanSpd/5;

142

143 if (sVar_tempO > sVar FollowPFCCmd)

144 {

145 //High spd & BEMF, need higher Vdcbus to support motor run
146 PFC TargetVolt = sVar tempO;

147 }

148 else //lower Vdcbus as possible to reduce power loss

149 {

150 //Low Spd or high Vac input, Vdc tracking Vac peak +10V
151 PFC TargetVolt = sVar FollowPFCCmd;

152 }

153

154 if (PFC TargetVolt > 3244) //MAX Vdc limit: 400V *8.11 = 3244 cts
155 {

156 PFC TargetVolt = 3244;

157 }

158 }

159 }

160 }

161 /*******End of Script*******/
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3 System design

This section provides the complete details of the schematics, layout and connectors. Please note that the
schematics, routing and Gerber files are done in Altium® Designer. Users who are interested in the original
project files or pdf files can visit the website www.infineon.com and log-in to mylInfineon and download on the
board’s web page.

3.1 Schematics

The major function blocks are introduced in Section 2.2 and Section 2.3 . Users who are interested in further
details can download the design files after logging in to the mylInfineon account on the board’s web page.

3.2 Layout

3.2.1 Main board layout

The main board is designed in a single layer and has a ring shape, with dimensions of 90 mm (D) x 65 mm (H).
The main board is manufactured with a copper thickness of 1 0z. (35 um).
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Figure 37 Top assembly print of the main board
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Figure 38 Bottom assembly print of the main board

Figure 39 Top layer of the main board
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Figure 40 Bottom layer of the main board

3.2.2 Daughter board layout

The daughter board is designed in double layers and has a square shape, with dimensions of 19 mm (L) x 15
mm (W)x 16 mm (H). The daughter board is manufactured with a copper thickness of 1 0z. (35 um).

Figure 41 Top assembly print of the daughter board

V3.1
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Figure 42 Bottom assembly print of the daughter board

Figure 43 Top layer of the daughter board

Figure 44 Bottom layer of the daughter board
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3.3

Bill of material

The complete bill of material is available on the download section of the Infineon homepage. A log-in is
required to download this material.

Table7 BOM of the most important/critical parts of main board
S. No. Ref Designator | Description Manufacturer Manufacturer P/N
CAP/ELCO/22 uF/450
V/20%/Aluminiumelectrolytic/-
1 Cle 25°C to 105°C/5.00 mm C X 0.60 | Wurth Elektronik | 860241478004
mm W 13.00 mm Dia X 26.50
mm H
CAP / FILM / 22nF/630V / 630V /
10% / MKP (Metallized
Polypropylene) / -40°C to .
2 CX1, CX2 105°C / 10.00 mm C X 13.00mm Wurth Elektronik | 890334023011CS
LX4.50 mmWX10.00 mmH/
THT
CAP/CERA /4.7 nF/2.6
kV/20%)/Y5U (EIA)/-40°C to
3 CY1, Cy2 125°C/10.00 mm C X 0.55 mm Kemet C961U472MZWDBAT317
W 13.00mmLX5.00mmTX
17.00 mmH
CAP/CERA/3.3nF/2.6
kV/20%/Y5U (EIA)/-40°C to
4 CY3,CY4 125°C/10.00 mm C X 0.55 mm Kemet C941U332MZWDBAT317
W11.00mmLX5.00mmTX
15.00 mmH
D1, D3, D4, g ON
5 D14 General purpose rectifier Semiconductor S1M
6 D3 1A, §0V— 1000.\/.glass Talwan 1N4007G-K
passivated rectifier Semiconductor
High speed 5 IGBT in
TRENCHSTOP 5 technology Infineon
! Ql copacked with RAPID1 fastand | Technologies IKADBNGSHS
soft antiparallel diode
Q2, Q3, Q4, Q5, | Cost effective monolithically Infineon
. . . . IKNO3N60ORC2
8 Qe6, Q7 integrated IGBT with diode Technologies 03N60RC
Vo TRENCHSTOP RC-Series for .
9 82,’ 82,’ 83,’* hard switching applications, ITn;!;i%TO ies IKDO4NGORC2
Sk VCE 600V, IC 4A &
Motor controller with
integrated high-voltage gate
10 U1 driver, Iptegrated script engine | Infineon . IMD112T-6F040
for application control Technologies
customization, thin-film-SOI-
technology with negative
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S. No. Ref Designator | Description Manufacturer Manufacturer P/N
transient robustness, built-in
temperature sensor

1 U2 Smgle—;hannellow-ade IGBT Infineon . 1ED44171NOLB
gate driver IC Technologies
Lowest component count,
energy-efficient off-line Power

12 . . . LNK305D

us switcher IC, 175 mA MDCM in Integrations 305DG

230 Vrms

*Q2',Q3',04',Q5',Q6', Q7' are alternatives of Q2, Q3, Q4, Q5, Q6, Q7, and Q2, Q3, Q4, Q5, Q6, Q7 are mounted by default.

Table 8 BOM of the most important/critical parts of daughter board
S. No. Ref Designator Description Manufacturer Manufacturer P/N
Remote receiver
1 U1l sensor, 40.0 kHz 14m Everlight IRM-3640T
Through Hole
XMC1000 industrial
microcontrollers ARM® | Infineon
2 vz Cortex®-M0 32-bit Technologies XMC1100-Q024F0064
processor core
3.4 Connector details
3.4.1 Main board connectors
Table 9 X1, X2, X3 AC input connectors
PIN Label Function
X1 L AC line input
X2 N AC neutral input
X3 EARTH Earth connector
Table 10 J1-iMOTION™ link connector
PIN Label Function
5 GND Ground
6 +5V On board 5V supply
7 RXDO MCEDesigner & firmware download
8 TXDO MCEDesigner & firmware download
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Table 11 J2 - Daughter board connector
PIN Label Function
1 IR Duty Duty signal from daughter board
2 GND Ground
3 +5V On board 5V supply
4 Reserved Reserved
3.4.2 Daughter board connectors
Table 12 J1 - Main board connector
PIN Label Function
1 IR Duty Duty signal to main board
2 GND Ground
3 +5V On board 5V supply
4 Reserved Reserved
Table 13 J2 - XMC1100 programming connector
PIN Label Function
1 +5V On board 5V supply
2 SWCLK SWCLK pin of serial wire debug (SWD)
3 SWD SWD pin of serial wire debug (SWD)
4 GND Ground
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4 System performance

4.1 PFCiTHD at rated condition

PFC performance is tested at a rated input voltage of 230 Vrms and output rated power of ceiling fan motor.

Table 14 PFCIiTHD at rated condition
Input voltage Input current (A) | PFCDC target (V) | Input power(W) | Power factor |iTHD(%)
(Vrms)
230 0.137 360 33.2~34.0 0.968~0.974 9.33~9.74
Legend CH1: lac, CH2: Vac, CH3: Vdc, CH4: IL
Condition ® Typical PWM setup for: 60 kHz PFC and 16 kHz motor PWM, 3-phase only mode, motor
speed: 360 rpm.
® PFC control parameters: Kpl=400, KxI=600, KpV= 1500, KxV=30
Tel _Slnp ) Tek Roll
A 1EC 61000—3—2 Harmonics, Class A
N P e e e N e ey L A L
. . R R . . s I B P Overall Pass :
POHC 5.15mA
g : ] POHL 251mA
- : T Freq Mag Mag Limit  Pass  Maxall  200% POHC
RMS Fail windows Limit Limit
pflac: A A A M B (Sl—(ilzz!Z (993)7 (12)6m EA)** n/a (1A3)6m n/a n/a W
N Nt Nt/ et e’/ g 2 1000 422m  574u  1.08  Pass  583u pass  nsn IHHIHNY
= 13 150.1 6.49 8.82m  2.30 Pass 8.85m Pass n/a
4 2001 276m 3754  430m  Pass  380u Pass  n/a
5 2501 3.73  5.08m 1.14  Pass  5.10m  Pass  n/a
6 300.1 275m 374 300m Pass 394 Pass n/a
7 3501 1.05  1.42m 770m Pass  1.43m  Pass  n/a j
S 4001  229m 3124  230m  Pass  326M pass  nsa
8 simi v @ 22 ame -2 lo 5002  22am  Josu  1n4m  pas  din  bes v ‘W’“
e Value Mean Min Max Std Dev ! — Acquisition Window too small 16:16:25 j
RMS 137.1mA  40.05m  23.63m  141.0m  38.58m Jun — i o Test to - Save
‘RMS 363.2v  362.7 361.5 363.2 346.2m MJ Apgolvc\'ig;oh H’?‘p:‘g'f'liscs ‘ '[:"ep:'"li Stﬂ&dcard J S‘I"Eﬁp J PP J t“geFaislé J
Tek Stop —~ Tek Prevu M 10.0ms
EHiLC_ o=l Tl Sl OIS e
Z00m Factor: TkX zoom Position: 3.87ms —~
0 3.850ms @ 184.0mA
O 3.852ms @ 240.0mA
vac onaN N o N PN ot N AT700Ms . AS6.00mA
g Npt” | Ry Nt Y K 0 I disdt  32.04kA/s
(5] 2
Rl
EHIL
@ soomA & @2 10.0ms 10.0M5/s @ 7 @ sooma & @2 Z 10.0ps T0.0MS/s @ 7
@ 200mA & ][ 1M points  4.00 A ] @ 200ma & }[ 1M points  4.00 A }
Value Mean Min Max Std Dev H value Mean Min Max Std Dev TN T
® s 136.7mA  136.7m  136.7m  136.7m  0.000 30 Jun 2021] | @ RM 197.7mA  197.7m  197.7m  197.7m  0.000 30 Jun 2
@ RMs 363.0V  363.0 363.0 363.0 0.000 @ RMs 3634V 363.4 363.4 363.4 0.000
Figure 45 PFCiTHD at rated condition
4.2 Bus voltage ripple
The bus voltage ripple test of input voltage is from 120 Vrms to 230 Vrms.
Table 15 Bus voltage ripple
Input voltage (Vrms) PFC DC target (V) Ripple voltage (V) (%)
120 300 8 2.6
150 300 8 2.6
230 360 7 1.92
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Legend CH1: lac, CH2: Vac, CH3: Vdc
Condition ® Typical PWM setup for: 60 kHz PFC and 16 kHz motor PWM, 3-phase only
mode, motor speed: 360 rpm.
Tekstop » TeKstop ——i _ : =
(] -17.70ms € 3120V D : O 5.500ms € 297.0V
© Alom © ooy ~— © Aetome T Aoy
f dv/dt 12.31kv/s .9 dvsdt o756 vis
Bpfvdc /"‘\ /\ F\ /‘\ B:Vdc /«\ /-\ /—\ /f\\ /e-\
HERT . [ i porats_aoca HET . | i o Shoa_
value Mean Min Max std Dev ’; value Mean Min Max Std Dev ’;
@ rMS 267.3mA  270.8m 260.9m 279.3m 4.932m 30.J0'-]“.‘|3§021 @ rRvIS 210.0mA  210.0m 210.0m 210.0m 0.000 ?gé:!‘l"go21
6RMS 302.3V 304.2 301.9 305.7 1.240 = ‘RMS 305.3V 305.3 305.3 305.3 0.000 —
[Tek stop H | I H H +
' O 100.0us € 370.0V
¥ - - [ (o) -5.200ms (& 356.0V
= = = A5.300ms A14.00V
i o . L dv/dt 2.642kV/s
i ,I.:c"\\ Jm\ Jm\ Jm‘ Jm W
E;Vdc ; g b o | T
@ 500mA & 2 : J[W.Oms 10.0M5/s @ S ] o
@ so0o0v 1M points 4.00 A :
value Mean Min Max Std Dev ’;
@ rRvIS 136.8mA  136.8m 136.8m 136.8m 0.000 30 Jun 2021
;RMS 363.0V 363.0 363.0 363.0 0.000 @
Figure 46 Bus voltage ripple at input voltage: 120 Vrms, 150 Vrms, 230 Vrms,
4.3 PFC IGBT Vce dv/dt performance
Table 16 PFCIGBT Vce dv/dt performance
Input voltage | Input power Input current | PFCDCtarget | Power
dv/dt of Vce (V/ns
(V) (W) (A) (V) factor / (V/ns)
Risi :4.2
120 34.2 0.283 260 1 ising edge: 4.280
Falling edge: 3.344
Rising edge: 4.306
230 33.9 0.154 360 0.974 g eCe
Faling edge: 2.897
Legend CH2: Vce, CH3: Vge, CH4: Ic
Condition ® Typical PWM setup for: 60 kHz PFC and 16 kHz motor PWM, 3-phase only mode, motor
speed: 360 rpm.
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Figure 47 PFC IGBT Vce dv/dt performance at input voltage =120V
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Figure 48 PFC IGBT Vce dv/dt performance at input voltage =230V
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4.4 PFC thermal performance
Table 17 PFC thermal performance
Input H
Input Input PFCDC Power Component with o
power AT(C)
voltage (V) (W) current (A) target (V) | factor max temperature
120 34.2 0.283 300 1 PFCIGBT 61.2
150 33.9 0.146 300 0.947 PFCIGBT 52.8
230 34.4 0.146 360 0.978 Motor IGBT 61.5
Condition ® PWM setup for: 60 kHz PFC and 16 kHz motor PWM, 3-phase only mode, motor speed: 360
rpm.
® PFC control parameters: Kpl=400, KxI=600, KpV= 1500, KxV=30.
120.0C
20.0C
7% Analysis ]tﬁﬂ Position | °Z, Obj. Par | €9 Image | ¥ Text comment
Label Value [°)C] Min Max| Max - Min Avg Stdev
Image 28.6 89.8 61.2
ARO1 43.0 89.7 46.7 78.6 14.0
ARO2 49.0 704 214 65.4 4.8
ARO3 754 80.0 4.7 79.2 0.6
ARO4 50.4 65.5 15.1 61.9 3.0
Figure 49 Input voltage =120V
120.0C
20.0C
¢ Analysis I‘%ﬂ Position | %, Obj. Par | €) Image | [ Text comment
Label | Value [°C] Min Max | Max - Min Avg Stdev |
Image 28.8 816 52.8
ARO1 41.0 816 40.6 68.1 13.2
AR02 54.9 721 17.2 69.3 27
ARO3 56.2 69.3 131 68.5 11
ARO4 57.1 70.2 13.2 66.2 41
Figure 50 Input voltage =150 V
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120.0C

20.0C

§¢ Analysis I% Position | %, Obj. Par] © Image | ¥ Text comment

Label Value [°C] Min Max| Max - Min Avg Stdev F
Image 283 89.8 61.5

ARO1 374 734 36.0 61.5 125
ARO2 63.8 89.8 26.0 85.1 6.1
ARO3 48.8 56.5 7.7 55.9 0.6
ARO4 68.5 735 51 719 12

Figure 51 Input voltage =230V

4.5 Inverter IGBT dv/dt performance

IKNO3N60ORC2 is used here for the inverter IGBT dv/dt performance test.

Table 18 Inverter IGBT dv/dt performance
.re Input Input power PFC DC target Power
Current position voltage (V) | (W) (V) factor dv/dt (V/ns)
At positive current | 230 34,5 360 09076 | Risingedge:0.576
Falling edge: 1.38
Rising edge: 0.514
Near zero current 230 34.5 360 0.976 Falling edge: 1.518
At negative current | 230 34.5 360 0.976 R|5|pg edge: 0.36
Falling edge: 1.325
Legend CH1: Vge for low side, CH4: Vge for high side ,CH3: phase output current, CH2: Vce for low side
Condition ® PWM setup for: 60 kHz PFC and 16 kHz motor PWM, 3-phase only mode, motor speed: 360
rpm.
® PFC control parameters: Kpl=400, KxI=600, KpV= 1500, KxV=30.
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4.6 Inverter IGBT dead time test
IKNO3N6ORC2 is used here for the inverter IGBT dead time test.
Table 19 Inverter IGBT dead time
Input voltage | Input power | PFCDC Power . .
Tdon+Tr (ns) | Tdoff+Tf (ns
(V) (W) target (V) | factor (ns) (ns) | Min dead time (ns)
120 35.8 260 1 84 512 428
Legend CH1: Vge for Low side, CH2: Vce for low side, CH3: phase output current.
Condition ® PWM setup for: 60 kHz PFC and 16 kHz motor PWM, 3-phase only mode, motor speed:
360 rpm.
® PFC control parameters: Kpl=400, KxI=600, KpV= 1500, KxV=30.
Tek Prevu M 4.00ms Tek Prevu : | M 4.00ms
jm R NE . | |||HH| "}l
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Figure 55 Inverter IGBT dead time
4.7 System test with infrared control

This test connects the main board and daughter board with cables provided, and uses the script code in
Section 2.4 for remote infrared control as shown in Figure 6. The test result is shown in Table 20.
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Table 20 System test result
Gear [Inputvoltage | Motor speed iTHD Input power Power factor | Input current
(Vrms) (rpm) (%) (w) (mA)
1 39 67.6 1.8 0.814 17
2 119 24.2 34 0.956 30
3 120 199 12.4 8.5 0.971 74
4 279 4.08 20.1 0.996 168
5 360 2.99 37.5 0.999 316
1 39 86.1 2.1 0.742 19
2 119 38.1 3.8 0.924 28
3 150 199 15.2 8.5 0.967 59
4 279 5.84 194 0.991 131
5 360 3.79 36.5 0.999 244
1 39 92.7 2.9 0.721 21
2 119 67.6 4.6 0.821 29
3 200 199 22.4 9.7 0.969 51
4 279 8.11 19.7 0.977 101
5 360 4.9 35.7 0.996 180
1 39 97.5 3.9 0.705 22
2 119 77.6 5.7 0.776 32
3 250 199 36.3 10.8 0.937 46
4 279 13.5 20.7 0.981 84
5 360 7.58 349 0.986 143
1 39 63.7 4.4 0.718 23
2 119 42.3 6.1 0.784 30
3 265 199 16.5 11.1 0.928 45
4 279 7.63 21.2 0.981 81
5 360 7.58 35.1 0.985 135
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5 References and appendices

5.1 Abbreviations and definitions
Table 21 Abbreviations

Abbreviation Meaning

CE Conformité Européenne

EMI Electromagnetic interference

UL Underwriters Laboratories

RC-D2 Reverse-conducting drive 2

5.2 References

[1] Infineon Technologies AG.
[2] Infineon Technologies AG.
[3] Infineon Technologies AG.
[4] Infineon Technologies AG.

[5] Infineon Technologies AG.

Datasheet of IKNO3N60ORC2 (2021) V1.0 www.infineon.com

Datasheet of IMD112T-6F040 (2020) V1.0 www.infineon.com

Datasheet of 1IED44171N01B (2021) V1.0 www.infineon.com

MCEWizard_V2.3 User Guide (2019) www.infineon.com

MCEDesigner_V2.3 Application Guide (2019) www.infineon.com

[6] Infineon Technologies AG. iMOTION™ Motion Control Engine Software Reference Manual (2021) V1.34

www.infineon.com

5.3

Additional information

In order to initiate testing, customers are advised to order the iIMOTION™ link; detailed information is listed in

Table 22.

The Infineon components on the board are listed in Table 22 as well. The customers can visit the corresponding
webpage for more information.

Table 22 Additional information on tools and Infineon components

Base part number Package Standard pack Orderable part number
Form Quantity

iMOTION™ link Container 1 IMOTIONLINK
IMD112T-6F040 PG-LQFP-40 Tape and reel | 1500 IMD112T6F040XUMAL
IKDO4N60RC2 PG-T0O252-3 Tape and reel | 2500 IKDO4N60RC2ATMAL
IKNO3N60RC2 PG-S0T223-3 Tape and reel | 2500 IKNO3N60RC2ATMAL
IED44171NO1B PG-S0OT23-5-1 Tape and reel | 3000 1ED44171NO1BXTSAL
IKAOSN65H5 PG-T0220-3 Tube 500 IKAOBN65H5XKSAL
XMC1100-Q024F0064 AB | PG-VQFN-24 Tape and reel | 6000 XMC1100Q024F0064ABXUMAL
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Revision history

Document Date of release Description of changes

version

V1.0 10/29/2021 Initial version.

V2.0 1/18/2022 Revised the software preparation and commissioning from Section
2.1.2 to Section 2.1.8.

V3.0 5/11/2022 Changed the PFC gate driver from IRS44273L to 1ED44171NO1B.

1) Changed the description of IRS44273L to IED44171N01B;

) Updated the picture in Figure 3;

) Updated the pictures in Figure37, Figure38, Figure39, Figure40;
) Updated the component information in Table 25.

A W N

V3.1 6/15/2023 1. Schematic and PCB modification:
1) Changed CX1 value from 100nF to 22nF.
2) Changed CX2 value from 330nF to 22nF.
3) Changed C5 and C7 value from 4.7nF to 10nF.
4) Changed C14 to DNI(unmounted).
2. Deleted EMI test
3. Deleted Surge test
4. Changed input voltage range to 120~265V ms
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